SECTION 074213 – METAL WALL PANELS
This specification is applicable for IMETCO FlatLok concealed clip wall metal wall tile system.

IF YOU DO NOT SEE INSTRUCTIONS IN BLUE TYPE ABOVE THIS NOTE, PLEASE ACTIVATE HIDDEN TEXT AS INDICATED:

- Word 2010: File → Options → Display … Select “Hidden Text” from the “Always show these formatting marks on the screen” group.
- Word 2007: MS Office Button (top left of menu bar) → Word Options (button in lower right of window) → Display … select “Hidden Text”.
- Word 1997 - 2003: Tools → Options … From the “View” tab, select “Hidden Text” from the “Formatting Marks” group.

PART 1 - GENERAL

1.1 RELATED DOCUMENTS
A. Drawings and general provisions of the Contract, including General and Supplementary Conditions and Division 01 Specification Sections, apply to this Section.

1.2 SUMMARY.
A. Work described in this section includes concealed clip, interlocking pre-formed metal wall tile system complete with perimeter and penetration flashing and closures.
B. Related work specified elsewhere:
   1. Structural steel.
   2. Steel girts and furring.
   3. Wood sheathing.
   4. Rough carpentry.
   5. Flashing and sheet metal. (Not wall panel related).
   6. Air barrier and vapor retarder.
   7. Thermal insulation.
   8. Sealants.

1.3 DEFINITIONS
A. American Architectural Manufacturer Association (AAMA):
   1. AAMA 621-96: Voluntary/Standard Specifications for High Performance Organic Coatings on Coil Coated Architectural Hot Dipped Galvanized (HDG) & Zinc-Aluminum Coated Steel Substrates
B. American Society for Testing and Materials (ASTM):
   1. A653-03: Specification for Steel Sheet, Zinc-coated (Galvanized) or Zinc-Iron Alloy-Coated (Galvannealed) by the Hot-Dip Process.

C. Sheet Metal and Air Conditioning Contractors National Association (SMACNA):

D. National Association of Architectural Metal Manufacturers (NAAMM)
   1. Metal Finishes Manual for Architectural and Metal Products

1.4 DESIGN AND PERFORMANCE CRITERIA.
   A. General Performance: Metal wall panel assemblies shall be furnished and installed without failure due to defective manufacture, fabrication, installation, or other defects in construction.

1.5 SUBMITTALS.
   A. Shop drawings: Show wall panel system with flashings and accessories in elevation, sections, and details. Include metal thicknesses and finishes, panel lengths, joining details, anchorage details, flashings and special fabrication provisions for termination and penetrations. Indicate relationships with adjacent and interfacing work. Shop drawings to be prepared by metal wall panel manufacturer.

   B. Financial Certification: Provide the building owner with a signed and notarized (sealed) affidavit by an officer of the panel system manufacturer which confirms a current minimum corporate asset-to-liability ratio of not less than 3:1 for the panel manufacturer, or its parent corporation. Financial support information and affidavit must be dated within 30 days prior to the product submittal.

   C. Warranty: Provide unexecuted specimen warranty documents for each warranty as required in specification article 1.10.

   D. Samples.
      1. Submit three (3) scale samples of fully formed panel, at least 5" x 15", and also a sample of color selected.
      2. Submit sample of concealed panel clip, fasteners, field applied sealants and all other system components.
1.6 QUALITY CRITERIA/INSTALLER QUALIFICATIONS.
A. Engage an experienced metal wall panel contractor (erector) to install wall panel system who has a minimum of three (3) years of experience specializing in the installation of metal wall systems.
B. Contractor must be certified by manufacturer specified as a supplier of the metal wall system and obtain written certification from manufacturer that installer is approved for installation of the specified system.
C. Successful contractor must obtain all components of wall system from a single manufacturer. Any secondary products that are required which cannot be supplied by the specified manufacturer must be recommended and approved in writing by primary manufacturer prior to bidding.
D. Fabricator/Installer shall submit work experience and evidence of adequate financial responsibility. Architect reserves the right to inspect fabrication facilities in determining qualifications.

1.7 DELIVERY, STORAGE, AND HANDLING.
A. Inspect materials upon delivery.
B. Handle materials to prevent damage.
C. Store materials off ground providing for drainage; under cover providing for air circulation; and protected from any debris.

1.8 PROJECT CONDITIONS
A. Weather Limitations: Proceed with installation only when existing and forecasted weather conditions permit metal wall panel work to be performed according to manufacturer's written instructions and warranty requirements.
B. Field Measurements: Verify actual dimensions of construction contiguous with metal wall panels by field measurements before fabrication.

1.9 COORDINATION
A. Coordinate sizes and locations of windows, doors, and wall penetrations with actual equipment provided.
B. Coordinate metal wall panels with rain drainage work, flashing, trim, and construction of other adjoining work to provide a leak proof, secure, and noncorrosive installation.

1.10 WARRANTIES
A. Endorse and forward to owner the following warranties:
   1. Manufacturer's standard 20 year finish warranty covering checking, crazing, peeling, chalking, fading, and adhesion of the prepainted sheet metal materials.
   2. Installer's 3 year warranty covering wall panel system installation and watertightness.
B. Warranties shall commence on date of substantial completion.
PART 2 - PRODUCTS

2.1 PANEL MATERIALS

   1. Recycle Content: Provide steel sheet with average recycled content such that postconsumer recycled content plus one-half of preconsumer recycled content is at least 45 percent.
   2. [0.032”] [0.040”] aluminum alloy 3003, 3004, 3005, or 3105 with H14 or H24 heat treatment, as per ASTM B209/209M.
   3. Texture: [Smooth] [Stucco Embossed] surface.
   4. Mill Finish Aluminum: The exposed and unexposed sheet surfaces shall be bare as furnished by the mill.
   5. Exposed Coil-Coated Finish:
      a. 2-Coat Fluoropolymer: AAMA 621. Fluoropolymer finish containing not less than 70 percent PVDF resin by weight in color coat. Manufacturers’ approved applicator to prepare, pretreat, and apply coating to exposed metal surfaces to comply with coating and resin manufacturers’ written instructions.
      b. Coating system shall provide nominal 1.0 mil (0.025 mm) dry film thickness, consisting of primer and color coat.
      c. Color shall be IMETCO’s ______.
      d. Color shall be selected from IMETCO’s Standard Colors
      e. Color: Custom color selected by architect.
      f. Color shall be: ______.
   6. Concealed Finish: Apply pretreatment and manufacturer's standard white or light-colored polyester backer finish, consisting of prime coat and wash coat with a minimum total dry film thickness of 0.5 mil (0.013 mm).

B. Panel Sealants:
   1. Sealant Tape: Non-curing, 100 percent solids, polyisobutylene compound sealant tape with release-paper backing. Provide permanently elastic, nonsag, nontoxic, nonstaining tape 1-inch- (13-mm-) wide and 1/16-inch- (3-mm-) thick.
   2. Exposed Sealant: ASTM C 920; elastomeric tripolymer, polyurethane, or other advanced polymer sealant; of type, grade, class, and use classifications required to seal joints in metal wall panels and remain weathertight; and as recommended in writing by metal wall panel manufacturer.

2.2 FIELD-INSTALLED THERMAL INSULATION

A. Refer to Division 07 Section "Thermal Insulation."
B. Polyethylene Vapor Retarders: ASTM D4397, 6 mils (0.15 mm) thick, with maximum permeance rating of 0.13 perm (7.5 ng/Pa x s x sq. m).

C. Unfaced, Polyisocyanurate Board Insulation: ASTM C 591, Type II, compressive strength of 35 psi (241 kPa), with maximum flame-spread index of 75 and smoke-developed index of 450.

D. Faced, Polyisocyanurate Board Insulation: ASTM C 1289, [Type I (foil facing), Class 1 or 2] [Type II (asphalt felt or glass-fiber mat facing), Class 2 or 3, Grade 3], with maximum flame-spread index of 75 and smoke-developed index of 450, based on tests performed on unfaced core.

E. Extruded-Polystyrene Board Insulation: ASTM C 578, Type IV, 1.60-lb/cu. ft. (26-kg/cu. m), with maximum flame-spread index of 75 and smoke-developed index of 450.

F. Molded-Polystyrene Board Insulation: ASTM C 578, [Type I, 0.9 lb/cu. ft. (15 kg/cu. m)] [Type II, 1.35 lb/cu. ft. (22 kg/cu. m)], with maximum flame-spread index of 75 and smoke-developed index of 450.

G. Unfaced, Glass-Fiber Board Insulation: ASTM C 612, Type IA or Types IA and IB; with maximum flame-spread index of 25 and smoke-developed index of 50, and with a nominal density of 3 lb/cu. ft. (48 kg/cu. m).

2.3 MISCELLANEOUS METAL FRAMING

A. Miscellaneous Metal Framing, General: ASTM C 645, cold-formed metallic-coated steel sheet, ASTM A 653, G90 (Z275) hot-dip galvanized

B. Subgirts: Manufacturer's standard C- or Z-shaped sections, 0.054-inch (16 gauge) (1.4-mm) nominal thickness.

C. Base or Sill [Angles] [Channels]: 0.068-inch (14 gauge) (1.7-mm) nominal thickness.

D. Hat-Shaped, Rigid Furring Channels:

   1. Nominal Thickness: As required to meet performance requirements
   2. Depth: [As indicated on drawings] [7/8 inch (22 mm)] [1-1/2 inches (38 mm)].
   3. Top flange: 1-1/8 inches (28.5 mm) minimum

E. Z-Shaped Furring: With slotted or nonslotted web, face flange of 1-5/8 inches (41 mm) minimum and depth as required to fit insulation thickness indicated.

   1. Nominal Thickness: As required to meet performance requirements, but not less than 0.043 inch (18 gauge) (1.1 mm).

F. Fasteners for Miscellaneous Metal Framing: Of type, material, size, corrosion resistance, holding power, and other properties required to fasten miscellaneous metal framing members to substrates.
2.4 SUBSTRATE BOARD
A. Glass-Mat Gypsum Sheathing Board: ASTM C 1177/C 1177M.
   1. Type and Thickness: [Regular, 1/2 inch (13 mm)] [Type X, 5/8 inch (16 mm)].
   2. The top surface of the substrate board shall be pre-primed to provide for adhesion of the self-adhering underlayment material.
   3. Product: Subject to compliance with requirements, provide Dens Glass Gold by Georgia-Pacific Corporation.
B. Substrate-Board Fasteners: Factory-coated steel fasteners and metal or plastic plates complying with corrosion-resistance provisions in FMG 4470, designed for fastening substrate board to structure.

2.5 UNDERLAYMENT MATERIALS
A. Self-Adhering with reinforcing scrim, Vapor Impermeable, High-Temperature Sheet: [50-mils- (1.3-mm-)] [60-mils- (1.5-mm-)] thick minimum, consisting of slip-resisting top surface laminated to SBS-modified asphalt adhesive, with release-paper backing; cold applied.
   1. Thermal Stability: Stable after testing at 250 deg F (121 deg C); ASTM D 1970.
   2. Low-Temperature Flexibility: Passes after testing at minus 20 deg F (29 deg C); ASTM D 1970.
   3. Seams shall be lapped in accordance with manufacturer’s recommendations.
   4. Underlayment shall be approved for 90 days (minimum) of exposure to UV and weather penetrations.
   5. Products: Subject to compliance with requirements, provide one of the following:
      a. Aqua Block 50 by IMETCO of Norcross, GA.
      b. Aqua Block 60 by IMETCO of Norcross, GA
      c. Dry-Dek by IMETCO of Norcross, GA.
B. Self-Adhering, Vapor Permeable Sheet: 25-mils- (0.64-mm-) thick, minimum, consisting of a multi-layer polypropylene porous film laminate with a vapor permeable adhesive; cold applied.
   1. Water Vapor Permeance, ASTM E 96 Method B: 50 perms (2,875 ng/(Pa*s*m2), minimum.
   2. Water Resistance, AATCC 127, 22-inch- (550-mm-) hydrostatic head for 5 hours: No leakage.
   3. Seams shall be lapped in accordance with manufacturer’s recommendations.
   4. Underlayment shall be approved for 120 days (minimum) of exposure to UV and weather penetrations.
C. Mechanically Attached, Vapor Permeable Sheet: 20-mils- (0.51-mm-) thick, minimum, consisting of multiple layers of UV stabilized spun-bonded polypropylene.

1. Water Vapor Permeance, ASTM E 96 Method B: 200 perms (11,500 ng/(Pa*s*m²), minimum.

2. Water Resistance, AATCC 127, 22-inch- (550-mm-) hydrostatic head for 5 hours: No leakage.

3. Seams shall be lapped in accordance with manufacturer’s recommendations.

4. Fasteners: Manufacturer's recommended corrosion-resistant, cap-headed steel or stainless steel nails, staples, or screws used in conjunction with manufacturer's spray adhesive, as appropriate for substrate.

5. Underlayment shall be approved for 270 days (minimum) of exposure to UV and weather penetrations.

2.6 MISCELLANEOUS MATERIALS

A. Concealed fasteners: Corrosion resistant steel screws, #10 minimum diameter x length appropriate for substrate, low profile pancake head. Use self-drilling, self-tapping for metal substrate or A-point for plywood substrate.

B. Exposed fasteners: 3xx series stainless steel screws (cadmium or zinc coatings are not acceptable) with neoprene sealing washer, or 1/8-inch- (3-mm-) diameter stainless steel rivets.

2.7 METAL WALL PANELS

A. General: Provide factory-formed metal wall panels designed to be field assembled by interlocking seams and incorporating concealed anchor clips.

B. Concealed clip, interlocking lapped seam wall tiles.

1. Panel shall be IMETCO FlatLok wall tile system as manufactured by Innovative Metals Company, Inc. (IMETCO), Norcross, Georgia, telephone 1-800-646-3826.

2. Alternate manufacturers are subject to full compliance with specification requirements, and shall be submitted for approval as follows.

   a. Manufacturers not listed above must submit for approval, ten (10) days prior to bid date, the following: Manufacturer's literature; certification of testing in accordance with specification requirements and sections 1.4 and 1.5; sample warranties in accordance with specification section 1.10; installer qualifications in accordance with specification section 1.6, and a list of five (5) similar projects in size and scope of work.

   b. No substitutions will be permitted after the bid date of this project.

3. Material: Aluminum sheet, [0.032 inch (0.81 mm)] [0.040 inch (1.02 mm)] thick. See 2.1 for finishes and color selection.


   a. Fabrication: Panels shall be factory formed from specified metal.
b. Wall tiles shall be factory notched and formed in such patterns as to provide for two flanged tab edges folded upward and two (2) flanged tab edges folded downward, thus allowing for engagement to adjacent tiles on all four edges.

c. Notching of patterns in flat sheet metal shall be factory performed using automated punching or laser cutting equipment; flame cutting, saw cutting, or hand snipping of pattern is not allowed.

d. Notched pattern shall include provisions for 1/8-inch- (3-mm-) diameter (nominal) punched relief holed at each end of the fold-line defined by the tab edges; this notching is required to prevent micro-cracking and subsequent creep fracture of material during freeze-thaw service conditions.

e. Folding of edge tabs shall be factory performed by automated folding equipment.

f. Orientation of continuous tile seam joint: [Vertical] [Horizontal].

g. In the opposite orientation direction, tiles shall be staggered by [one-half] [one-third] [one-quarter] the width of the adjacent course of tiles. See pattern as shown on drawings for additional information.

h. Tile installed coverage width: [13-1/2 inches (343 mm)] [21 inches (533 mm)] [45 inches (1,143 mm)], nominal.

i. Tile installed coverage length: ______ inches, nominal.

j. Anchor clip shall be 20 gauge galvanized steel, 1-7/8-inches- (48-mm-) long, pre-punched for two (2) screw fasteners per clip.

2.8 ACCESSORIES

A. Flashing and Trim: Formed from same material and gauge as wall panels, prepainted with coil coating. Provide flashing and trim as required to seal against weather and to provide finished appearance. Locations include, but are not limited to, head, sill, corners, jambs, framed openings, fasciae, and fillers. Finish flashing and trim with same finish system as adjacent metal wall panels.

2.9 FABRICATION

A. Fabricate and finish metal wall panels and accessories at the factory to greatest extent possible, by manufacturer's standard procedures and processes and as necessary to fulfill indicated performance requirements. Comply with indicated profiles and with dimensional and structural requirements.

B. Form flashing components from full single width sheet in minimum 10'-0" (3 m) sections. Provide mitered trim corners, joined using closed end pop rivets and butyl-based, solvent released one-part sealant.
C. Sheet Metal Accessories: Fabricate flashing and trim to comply with recommendations in SMACNA's "Architectural Sheet Metal Manual" that apply to the design, dimensions, metal, and other characteristics of item indicated.

1. Form exposed sheet metal accessories that are without excessive oil canning, buckling, and tool marks and that are true to line and levels indicated, with exposed edges folded back to form hems.

2. Sealed Joints: Form nonexpanding but movable joints in metal to accommodate butyl-based sealant to comply with SMACNA standards.

3. Conceal fasteners and expansion provisions where possible. Exposed fasteners are not allowed on faces of accessories exposed to view.

4. Fabricate cleats and attachment devices of size and metal thickness recommended by SMACNA's "Architectural Sheet Metal Manual" or by metal wall panel manufacturer for application, but not less than thickness of metal being secured.

2.10 FINISHES

A. Comply with NAAMM's "Metal Finishes Manual for Architectural and Metal Products" for recommendations for applying and designating finishes.

B. Protect mechanical and painted finishes on exposed surfaces from damage by applying a strippable, temporary protective covering before shipping.

C. Appearance of Finished Work: Noticeable variations in same piece are not acceptable. Variations in appearance of adjoining components are acceptable if they are within the range of approved Samples and are assembled or installed to minimize contrast.

PART 3 - PREPERATION & EXECUTION

3.1 EXAMINATION

A. Examine substrates, areas, and conditions, with Installer present, for compliance with requirements for installation tolerances, metal wall panel supports, and other conditions affecting performance of the Work.

B. Examine primary and secondary wall framing to verify that girts, studs, angles, channels, and other structural panel support members and anchorages have been installed within alignment tolerances required by metal wall panel manufacturer.

C. Examine solid wall sheathing to verify that sheathing joints are supported by framing or blocking and that installation is within flatness tolerances required by metal wall panel manufacturer.

D. Examine roughing-in for components and systems penetrating metal wall panels to verify actual locations of penetrations relative to seam locations of metal wall panels before metal wall panel installation.

E. For the record, prepare written report, endorsed by Installer, listing conditions detrimental to performance of the Work.

F. Proceed with installation only after unsatisfactory conditions have been corrected.
3.2 PREPARATION

A. Clean substrates of substances harmful to insulation, including removing projections capable of interfering with insulation attachment.

B. Substrate Board: Install substrate boards over wall structure on entire wall surface. Attach with substrate-board fasteners.
   1. Install substrate board with long joints in continuous straight lines, horizontally oriented with end joints staggered between courses. Tightly butt substrate boards together.
   2. Comply with [UL] [FMG] requirements for fire-rated construction.

C. Miscellaneous Framing: Install sub-framing, furring, and other miscellaneous wall panel support members and anchorage according to metal wall panel manufacturer's written instructions.

D. Establish straight, side and crosswise benchmarks

E. Use proper size and length fastener for strength requirements. A low profile fastener head of approximately 1/8 inch (3 mm) maximum is allowable beneath the panel.

F. All walls shall be checked for square and straightness. Inside and outside corners may not be plumb; set a true line for the corner flashing with string line.

G. Measure the wall lengthwise to confirm panel lengths and verify clearances for thermal movement.

3.3 THERMAL INSULATION INSTALLATION

A. Polyethylene Vapor Retarder: Extend vapor retarder to extremities of areas to be protected from vapor transmission. Repair tears or punctures immediately before concealment by other work.

B. Board Insulation (reference 2.2.C-G): Extend insulation in thickness indicated to cover entire wall. Comply with installation requirements in Division 07 Section "Thermal Insulation."
   1. Erect insulation and hold in place with hat channels or Z-shaped furring. Securely attach narrow flanges of furring members to wall framing with screws spaced 24 inches (610 mm) o.c.

3.4 UNDERLAYMENT INSTALLATION

A. Sheet Underlayment: Apply primer if required by manufacturer. Comply with temperature restrictions of underlayment manufacturer for installation. Apply over entire wall surface, wrinkle free, in shingle fashion to shed water, and with end laps of not less than 6 inches (150 mm) staggered 24 inches (610 mm) between courses. Overlap side edges not less than 3-1/2 inches (90 mm). Roll laps with roller. Cover underlayment within 90 days.

3.5 METAL WALL PANEL INSTALLATION

A. All details will be shown on in accordance with approved shop drawings and manufacturer's product data, within specified erection tolerances.
B. Directly over the completed wall substrate, install wall tiles with concealed anchoring clips. All clips will be fastened into the structural wall substrate at 16-inches (406-mm) on center, maximum, along both vertical and horizontal panel seam joints.

C. Installation of Wall Tiles: Panels are installed sequentially in courses from bottom-to-top of wall or laterally across the wall, depending on configuration of the continuous and staggered joint patterns depicted on the drawings. In all cases, interlocking tile tabbed flanges shall shed water in a shingle fashion from top of wall to bottom of wall.

D. Isolate dissimilar metals and masonry or concrete from metals with bituminous coating. Use gasketed fasteners where required to prevent corrosive action between fastener, substrate, and panels.

E. Limit exposed fasteners to extent indicated on contract drawings.

F. Seal laps and joints in accordance with wall panel system manufacturer's product data.

G. Coordinate flashing and sheet metal work to provide weathertight conditions at wall terminations. Fabricate and install in accordance with standards of SMACNA Manual.

H. Provide for temperature expansion/contraction movement of panels at wall penetrations and wall mounted equipment in accordance with system manufacturer's product data and design calculations.

I. Installed system shall be true to line and plane and free of dents, and physical defects. In light gauge panels with wide flat surfaces, some oil canning may be present. Oil canning does not affect the finish or structural integrity of the panel and is therefore not cause for rejection.

J. At joints in linear sheet metal items, set sheet metal items in two ¼-inch- (6-mm-) beads of butyl sealant. Extend sealant over all metal surfaces. Mate components for positive seal. Allow no sealant to migrate onto exposed surfaces.

K. Remove damaged work and replace with new, undamaged components.

L. Touch up exposed fasteners using paint furnished by the panel manufacturer and matching exposed panel surface finish.

M. Clean exposed surfaces of wall panels and accessories after completion of installation. Leave in clean condition at date of substantial completion. Touch up minor abrasions and scratches in finish.

3.6 ERECTION TOLERANCES

A. Installation Tolerances: Shim and align metal wall panel units within installed tolerance of 1/4 inch in 20 feet (6 mm in 6 m) at location lines as indicated and within 1/8-inch (3-mm) offset of adjoining faces and of alignment of matching profiles.

3.7 FIELD QUALITY CONTROL

A. Manufacturer's Field Service: Engage a factory-authorized service representative to inspect metal wall panel installation, including accessories. Report results in writing.
B. Remove and replace applications of metal wall panels where inspections indicate that they do not comply with specified requirements.

C. Additional inspections, at Contractor's expense, will be performed to determine compliance of replaced or additional work with specified requirements.

3.8 CLEANING

A. Remove temporary protective coverings and strippable films, if any, as metal wall panels are installed unless otherwise indicated in manufacturer's written installation instructions. On completion of metal wall panel installation, clean finished surfaces as recommended by metal wall panel manufacturer. Maintain in a clean condition during construction.

B. Replace metal wall panels that have been damaged or have deteriorated beyond successful repair by finish touchup or similar minor repair procedures.

END OF SECTION 074113